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Guidelines for the Preparation of Ed.D. Capstone Reports 

 

SUBMISSION DEADLINES 
Spring  

• Initial Submission Deadline - 12th week of the Semester, Friday, 4:30 PM 
• Final Submission Deadline - 13th week of the Semester, Friday, 4:30 PM 
For example, for Spring 2025 the deadlines are 
• Initial Submission Deadline - April 4, 2025, 4:30 PM 
• Final Submission Deadline - April 11, 2025, 4:30 PM 

Summer 

• Initial Submission Deadline - 3rd week of the Semester, Friday, 4:30 PM 
• Final Submission Deadline - 4th week of the Semester, Friday, 4:30 PM 
However, in Summer 2025 the deadlines are on Thursdays, due to the holiday! 
• Initial Submission Deadline – Thursday, June 26, 2025, 4:30 PM 
• Final Submission Deadline – Thursday, July 3, 2025, 4:30 PM 

 

Fall  

• Initial Submission Deadline - 12th week of the Semester, Friday, 4:30 PM 
• Final Submission Deadline - 13th week of the Semester, Friday, 4:30 PM 
However, in Fall 2025 the initial deadline is on Thursday, due to the holiday! 
• Initial Submission Deadline – Thursday, November 6, 2025, 4:30 PM 
• Final Submission Deadline - November 14, 2025, 4:30 PM 

 

Important Information: 

• You may submit your paper any day of the year. 
• To be eligible for a certain graduation date, submit a complete paper by the initial 

deadline. Include all required pages. It is acceptable for you to make additional content 
edits as required by your committee prior to the final submission deadline. 

• Revise your paper based on the feedback provided by the administrator and resubmit it. 
This process continues until the paper meets the guidelines and format required. 

• There is not a fee for Capstone Report submissions to OpenSIUC. 
• The initial and final submission deadlines are firm. If you cannot meet both deadlines, 

then your paper will be considered for the following semester graduation. 
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Organization of Pages 

Download and use a template for your paper! Here is the link Template 

The pages of your paper should be in the following order: 

1. Title page 
2. Copyright statement (optional) 
3. Approval page 
4. Abstract (optional) 
5. Dedication (optional) 
6. Acknowledgments (optional) 
7. Preface (optional) 
8. Table of Contents 
9. List of Tables (with titles and page numbers – required if you have more than one table) 
10. List of Figures (with titles and page numbers – required if you have more than one figure) 
11. Text/Body 
12. Exhibits (tables, figures, photographs, etc. – required if you are presenting all of your 

tables and figures after the body of your paper) 
13. References (or other appropriate title prescribed by your program’s style manual) 
14. Appendices (optional – required if you have copyright permission or other documents 

that do not fit elsewhere in your paper) 
15. Vita  

TITLE PAGE 

• Make sure that your paper title on the title page, the approval page, the abstract page, the 
vita page, your Oral Defense and Capstone Report Approval forms match exactly. 

• Month Year at the bottom of this page is the month and year of graduation. This line must 
be placed at the bottom 1-inch margin of the page. 

APPROVAL PAGE 

• Only the names (not the signatures) of your committee are needed for this page. (The 
signatures will be on the original paper Capstone Report Approval form that is submitted 
to the Graduate School.) 

• Date on this page is the date on which your committee signs your approval form. It 
should be in the format Month Date, Year, for example, March 8, 2023. 

ABSTRACT 

• Date on this page is the date of your defense in the format Month Date, Year. 

https://siu.edu/admissions/graduate/academic-support/thesis-dissertation-research/capstone-report-guidelines.php
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TABLE OF CONTENTS 

• Do not list the Table of Contents as an entry on the Table of Contents page. 
• Put the ones digit of every page number in a straight vertical line at the right margin. 
• Include the titles of Chapters and Appendices. 
• Where chapter titles are longer than one line, end the first line before it reaches the page 

number vertical line, and then indent the first word of the second line so that it starts 
under the first word of the first line. (See Template.) 

• Indent the chapter listings under the word CHAPTERS, and indent the appendices 
listings under the word APPENDICES. 

• Table of Contents are already created on the templates, and you only need to customize 
this page. Another option is to create an active Table of Contents by following the 
instructions below. 

Inserting a table of contents using the inbuilt option from MS Word 

• In Word, tables of contents rely on your use of styles to format headings. If you already 
used the Heading 1, Heading 2, and other heading styles to format your document, you’re 
ready to insert your Table of Contents. Follow these steps to insert a Table of Contents: 

o Click where you want to create the table of contents and click the References tab.  
o In the Table of Contents group, click Table of Contents. 

 
o Choose the style of Table of Contents you wish to insert. Automatic Table 1 

creates a Table of Contents titled Contents. Automatic Table 2 creates a Table of 
Contents titled Table of Contents. So, Automatic Table 2 is recommended.  

o Manually add the sub titles CHAPTER and PAGE and align them utmost right 
and left respectively. 

o Word will create a Table of Contents from the document text you styled with one 
of the first three heading styles: Heading 1, Heading 2, and Heading 3. The Table 
of Contents will include a string of dots between the heading text and the page 
number for each heading. 

o When readers hover over a page number, the headings are highlighted which 
reminds that they can use the Table of Contents for navigation. 



5 
 

• After the headings are inserted, change the font style of the title TABLE OF 
CONTENTS, center align it, make it all capitals and also set the font color to Black.  

• Set the line spacing to 2.0, change the font style, size of the headings, page numbers (if 
needed) to make it consistent with the rest of the document.  

Updating Table of Contents 

After you’ve edited your document, page numbers and headings may change, which will make 
your Table of Contents incorrect!  

• To update your Table of Contents, right-click in the table and choose Update Field 
or 

• choose Update Table from the Table of Contents group on the References tab. Select 
entire table or page numbers only and click OK to regenerate the table of contents from 
your headings. 

 

No Heading styles? 

• If the headings in your document aren’t formatted with styles, before inserting your table 
of contents, select each of the top-level headings for your Table of Contents and apply the 
Heading style from the Styles group on the Home tab of the ribbon. 

 

or 

• Follow the templates and manually type in the headings to create a Table of Contents. 
 

LIST OF TABLES and LIST OF FIGURES 

• Put the ones digit of every page number in a straight vertical line at the right margin. 
• It is required to include table/figure title next to table/figure number. 
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• Where table/ figure titles are longer than one line, end the first line before it reaches the 
page number vertical line, and then indent the first word of the second line so that it starts 
under the first word of the first line. 

For example… 
Figure 23. The effect of switch cost on the total annual cost and the optimum number of  
                  switches....................................................................................................................... 65 

 

Formatting Guidelines 

FONTS 
• Use the same font throughout your paper. Some standard fonts to choose from: Times 

New Roman, Bookman, Courier, or Ariel. 
• The regular text in the body of the document should use a 10 or 12 point font size.  
• Headings and subheadings may go up to 14 point but must be of the same font style as 

the body of the text. 
• Bold and Italics may be used. In general, italics is used for Genera, species, letters, 

words or phrases cited as a linguistic example, and foreign words. Bold and italics may 
be used to distinguish heading and sub-heading levels; follow your department 
guidelines, and be consistent throughout your paper. 

• For tables, six (6) point font should be the smallest used. Try to use the same size as the 
rest of the body, if possible. 

SPACING 
• The body of the document must be double spaced.  
• There should be no extra spacing between paragraphs. 
• There should be no extra spacing before and after each sub-heading. 
• Spacing within the table may be single or double spaced based on the readability of the 

data. 
• There should be a judicious use of spacing to "set off" tables and figures; typically, one 

double space before and after the table. Again, once spacing is chosen, keep it consistent 
throughout. 

• Places where single spacing is acceptable: 
• Between the lines of a title or heading that takes up more than one line. 
• Between the lines of a long quote that is indented. 
• Within a figure or table. 
• Between the lines of a figure/table title or explanation/description  
• Within a reference in the References section. If you single space between the multiple 

lines of a reference, then you should insert a blank space between reference entries. 
• Within footnotes. 

How to Double Space the Document 

• Navigate to Design tab. 



7 
 

• Go to Paragraph Spacing (on Top Right) and Set that to Double. 

 
or 

• Select the paragraph which needs to be double spaced. 
• Navigate to Home →Paragraph line spacing options →2.0 

Deleting extra space above each sub heading, paragraphs.  

Only 2.0-line space is allowed throughout your work. Sometimes, though the line spacing is set 
to double, you still can see some extra space between the lines, especially above each sub 
heading, new paragraph etc.  

To fix this: 

• Select text.  
• On Home tab → Paragraph → Click paragraph Settings button on the bottom right. 

 

 
• On Indents and Spacing tab set the Spacing to 0 for both Before and After tabs. 
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• Click OK. 
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TEXT JUSTIFICATION 

• The text in chapters should be left justified only, unless your program requires full 
justification of text (e.g., Mathematics). 

• Text on title page and approval page are centered. 
• Chapter titles are centered, and other headings may be centered, as fits your program- 

designated style. 

MARGINS AND INDENTATIONS 
• Margins are one inch all around. So, text should start one inch below the top of the page 

and end one inch above the bottom of the page.  
• Pages with charts, tables, and figures may have greater margins than listed but may not go 

into the required margins. 
• Paragraph indentations should be a uniform five spaces.  
• With a heading at the bottom of a page, when there is not room for at least one line of 

text under it, move the heading to the next page. In this situation, it is acceptable to have 
a larger bottom margin. 

PAGINATION 
• No page numbers on Title page, Copyright page, or Approval page. 
• The pages after the Approval page and preceding the text, i.e. Abstract,  



10 
 

Table of Contents etc. should be numbered using lower case Roman numerals (i, ii, iii, ..) 
starting with Abstract.  

• Roman numeral page numbers must be centered and positioned one-half inch from the 
bottom of the page. 

• Text pages, References/Bibliography, Appendices and Vita should consist of Arabic 
numerals (1, 2, 3..) only, without punctuation, embellishment, or running headers. This 
numeral paging should be continuous. 

• The Arabic page numbers should be located right-aligned on the top of the page.  
• Page numbers need to be consistent with the same font style and size as the regular text. 
• If a page of your document is formatted with landscape orientation, the header and footer 

of the page are also formatted with landscape orientation. Page numbers on landscape-
oriented pages should be in the same position as page numbers on portrait-oriented pages. 
For example, if portrait pages have page numbers on the top right, then the landscape pages 
will also have page numbers on the top right corner. 

Creating different page number styles in one document  

• Use the Section break formatting to have different page numbering styles. A new section is 
created that starts on the next page. With this type of section break, you can apply different 
page numbers, headers, footers, page orientation, paper size, and vertical alignment to the 
sections in the document. If you are using templates, this is already taken care. 

Capstone Report paper should have the following sections: 

Section 1 - No page numbers on Title page, Copyright page, or Approval page. 

Section 2 - The pages after the Approval page and preceding the text, i.e. Abstract, 
Acknowledgements, Table of Contents etc. should be numbered using lower case Roman 
numerals (i, ii, iii ..) starting with Abstract. 

Section 3 - Text pages, References/Bibliography, Appendices and Vita should consist of 
Arabic numerals (1, 2, 3..) 

By default, word document comes with Section 1. So, creating Section breaks 2,3 should 
serve the purpose.  

For creating Section 2  

• Click at the end of Approval page. 
• Click Layout tab→ Breaks then under Section Breaks, click Next Page. So, this 

creates a new section 2 from Abstract. 
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• Click on the header/ footer of Abstract page (Section 2) and click Link to Previous button 
to disable it. This unlinks Section 2 from Section 1 and allows user to create Roman 
page numbers in Section 2 without creating page numbers in section1.  
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For creating Section 3 

• Click at the end of page with last roman page number. 
• Click Layout tab→ Breaks then under Section Breaks, click Next Page. So, this 

creates a new section 3 from Chapter 1 (text). 
• Click on the header/ footer of Chapter 1 (Section 3) and click Link to Previous button to 

disable it. This unlinks Section 3 from Section 2 and allows to create Arabic page 
numbers in Section 3 without messing up with roman numbers in section 2. 

Note: Don’t forget to unlink header and footer of each section from its previous section. By 
default, the Link to Previous button is enabled. You can see it dark grey if it is enabled.  

Inserting roman page numbers for front pages  

• Double click on the footer section of the Abstract page (Section 2). It automatically opens 
the Design tab.  

• Click Page number → Bottom of the page and choose center alignment (Plain Number 2).  

 

• It assigns Arabic page numbers 1, 2, 3 ..  
• Select page number and change the font style and size to make it consistent with the text.  
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• Now right click on the page number and choose Format Page numbers to change the 

format from Arabic to Roman page numbers. 
• Choose Roman number format from the drop-down list, start at i and click OK. 

 

Inserting Arabic Page numbers 

• Arabic page numbers are located right-aligned on the top of the page  
• To have them aligned on the top- right, double click on the header section of the first 

chapter page. 
• Click Page number → Top of the page and choose right alignment (Plain Number 3).  
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• It assigns Arabic page numbers 1, 2, 3 ..  
• Select page number and change the font style and size to make it consistent with the text. 

 
Changing the orientation of a particular page(s) to Landscape  

• Create a Section break - next page on the previous page for which the orientation has to 
be changed.  

• Add another Section break at the end of last landscape page.  
• Click the header, to confirm a new section has been created. This allows you to change 

the page layout of only this section without changing the layout of the entire document. 
• Click Layout→  Orientation  and set the Orientation to Landscape  
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HEADINGS AND SUBHEADINGS 
• Chapter titles – All chapter titles and top headings should be in all capital letters. 

(including front and back content, e.g., PREFACE, CHAPTER 1, APPENDIX, etc.) 
• Either bold all top headings or don’t bold any. 
• Use numerals (1,2,3...) instead of words (ONE, TWO, THREE) to represent Chapter 

numbers. E.g. CHAPTER 1 instead of CHAPTER ONE (in the Table of Contents and on 
the heading for the chapter). 

• Be consistent with chosen format style for headings and sub-headings throughout your 
document.  

• Don’t leave a heading without text underneath it at the very bottom of the page. 

MULTIMEDIA OBJECTS 
Multimedia object types include oversized tables, complex equations, graphs, diagrams, digital 
pictures, digital video, digital audio, virtual reality, and even computer software that you have 
developed. 

• Multimedia objects and oversize maps/files may be included as an Additional file. 

TABLES AND FIGURES 
Most simple objects like tables, graphs, and diagrams can be embedded in your paper using your 
Word Processor. Here are some guidelines when you embed the objects. 

• If the object is the first thing on the page, begin at the top one-inch margin. It can be 
centered left-to-right on the page, but do not center it top-to-bottom on the page.  

• Your page can have multiple objects provided they all completely fit, without 
compromising on margins. 

• Number the object according to its position in the chapter (e.g., in Chapter 5 you may 
have a Table 5.1, Table 5.2, and Figures 5.1, 5.2, and 5.3). 

• Put table titles above the tables. Figure titles can be located either above or below the 
figures, but choose above or below and stay consistent throughout your paper. 

• When tables or figures are too wide to fit within the required one-inch margins, either 
reduce the size (if possible) or change the orientation of that page to landscape. 
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• Include a LIST OF TABLES page if you have more than one table in your paper. Include 
a LIST OF FIGURES page if you have more than one figure in your paper. 

• If your tables/figures are not within the text of your paper, these are called EXHIBITS. 
You should still include a LIST OF TABLES or LIST OF FIGURES page. Your Exhibits 
page should be located directly after the last page of your last chapter/before the 
References page, and it must be listed in your Table of Contents.  

 

INCLUDING PREVIOUSLY-PUBLISHED CONTENT 
To include content that has been published elsewhere (even if you are the author), you must 
follow certain steps to ensure you avoid copyright infringement. 

• Content that is in the PUBLIC DOMAIN does not have copyright issues. This content 
includes only works created and published by the U.S. government and works where the 
author has been deceased for over 70 years. All other published works are covered by 
copyright laws. 

• To include previously published content (anywhere in your paper, including in the 
appendix) that is not in the public domain, you must do two things: 1.) Cite the source 
where you found the content under the content wherever you are including it. Use a full 
citation with title, author, date, publisher, URL (if appropriate), etc.   2.) Include the 
permission that you received to include the content in your paper. This permission might 
come in various forms: an email from the publisher, an excerpt from original 
work/website that states that anyone has permission, or (if you were the author) a clause 
from your publishing contract. (see Example 1 below.) 

• Examples of content that must have permission include: an entire survey instrument* that 
someone else wrote and published, a unique and complicated figure that someone else 
designed and published, a poem or song that someone else wrote and published, a 
photograph or image that someone else took/created and published. 

• You have more flexibility to use PART OF something without getting permission. For 
example, you could provide the first question of the survey instrument, a couple lines of 
the poem, or you could adapt part of the complicated figure to fit your research (see 
Example 2 below.) If you use only a small part of the content, this is considered FAIR 
USE. You can do this without getting permission, but you still must cite the original 
source. If you adapted the work, state that you adapted it as part of the citation. Also 
include the original source in your list of REFERENCES. 

• FAIR USE can also be achieved by using a small version of an image or photograph (as 
opposed to a larger one). Use the smallest size possible that will be acceptable for your 
purposes. Also, it is best to include previously-published content only when it is intricate 
to the message of your paper, when it is the best way to elaborate or support your 
argument. Always cite the original source of an image or photograph. 

• Many publishers have forms to request permission on their websites. If there is no form, 
an email is also an acceptable method of requesting permission. Be sure to tell them that 
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you want to include the content in your thesis or dissertation. They almost always say yes 
to this type of use. 

 

* Note the difference between being able to use a survey instrument to gather data for your 
research study AND being able to include that entire survey instrument in your appendix! 
These two actions require different and separate permissions. 

See below for examples. 
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Example 1  

This example shows where a student included a previously-published figure, properly cited its 
source, found permission on the publisher’s website, and included the permission in the 
appendix. 
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Example 2  

This example shows where a student included just a small part of a previously-published attitude 
scale (in order to avoid needing publisher permission) and properly cited the source where the 
entire attitude scale could be found. 

 

 

APPENDIX 
• List of terms, definitions, questionnaires, and other supplemental information which is 

useful, but not essential, to the body of the research paper may be included in an 
appendix. 

• When you have more than one appendix, name each Appendix with a letter (A, B, C, 
etc.) and list each Appendix separately with a title in the Table of Contents. 

• An APPENDICES cover page prior to Appendix A in your paper is optional. 
• Because these final papers will be available online, you must remove all signatures from 

any documents that you include in your paper. 

VITA 
• Only include the degrees you have already earned, not the degree in progress, on this 

page.  
• Only list publications that were already published or accepted, not the ones in process. If 

a publication has been accepted but not yet published, note it with (in press). 
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Submission Guidelines 

BEFORE YOU BEGIN THE SUBMISSION PROCESS, PLEASE MAKE SURE YOU HAVE THE 
FOLLOWING ITEMS: 

• The submission's title 
• An abstract of 250 words or less (optional)  
• A list of keywords (10 maximum) (optional) 
• Full name of your committee chair and committee members 

• Your document in pdf 
• Additional files, if any. 

SUBMISSION PROCESS FOR Ed.D. CAPSTONE REPORT 
• Navigate to the OpenSIUC submission site 

https://opensiuc.lib.siu.edu/gs_caps/author_guidelines.html  
•    You will need an account to make your submission. Click on the “My Account” link in the 
upper right of the screen to set up your account. 

 
•    Login to your account. 
• Click on the "Submit Research" link in the lower left of the screen. 

https://opensiuc.lib.siu.edu/gs_caps/author_guidelines.html
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• Fill in all the details, browse and upload your Capstone Report.   
• Submit any associated supplementary multimedia files (optional). 
•    When the preceding steps are complete, click on the “Submit” button at the bottom of the  
 screen. This completes the submission process.  
 

IMPORTANT DETAILS ABOUT THE SUBMISSION PROCESS 
• Submit complete paper by initial submission deadline. 
• Any day before the initial deadline is okay for submission. 
• After you submit, please allow us a couple of days to get back to you via email. We will 

send you a list of formatting edits that must be made. 
• Be patient because others are also submitting, and it takes a while to review each paper. 
• Make the required edits and then submit the revised version via the same OpenSIUC 

account. 

After your paper has been approved… 

• You will receive an email message. 
• You do NOT have to submit your paper again. The final submission, the version that was 

approved, is locked into the system and used as the final, official version.  
• Your file is sent to the Graduate School Graduation Office for graduation clearance.  
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Note: The Graduate School Graduation office will NOT send you any message if you have been 
cleared for graduation. Your program will be notified only if there is a problem.  

FEES 
• There is not a fee for Capstone Report submission. 

 
COPYRIGHT 
 

Copyright Permission for Use of Published Work 

• To use an already published work (text, photograph, drawing, data etc.) in your paper, 
you must obtain permission from the publisher of that work. 

• Most publishers have forms to request permission on their websites. If there is no form, 
an email is also an acceptable method of requesting permission.  

• Cite the source in your paper at the point of use, and insert the permission letter/email in 
the Appendix.  

 

ORDERING BOUND COPIES 

• The SIU Bookstore no longer offers to professionally bind student papers. You are 
welcome to work with any printing company to bind your officially approved paper. 

 
FORMS 

• The Oral Defense and Capstone Report Approval forms are available on 
https://siu.edu/admissions/graduate/resources/forms.php . 

• The Graduate School requires one Oral Defense and one Capstone Report Approval form 
before the Final Submission Deadline in order to accept your paper. Your program 
representative will submit one original of each of these forms to the Graduate School. 

• Hand signatures must be original – no fax, scans, stamps, or color printed. Digital 
signatures must be either Adobe Reader signed or State of Illinois official digital signed. 

• Committee members who are away from campus and cannot sign the forms by hand may 
e-sign them. The instructions for getting the e-signatures are available on 
https://siu.edu/admissions/graduate/resources/forms.php .  

 
LETTER OF COMPLETION 
If you need to have official university confirmation that you have completed your degree, prior 
to graduation day, then you may send an email with your dawg tag to grad.graduation@siu.edu 
to request a Letter of Completion. This letter cannot be written until after you are completely 
cleared for graduation. 
 
 

https://siu.edu/admissions/graduate/resources/forms.php
https://siu.edu/admissions/graduate/resources/forms.php
mailto:grad.graduation@siu.edu
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INSTITUTIONAL REVIEW BOARD (IRB) 
• If you were required to secure permission for using human subjects or animals in your 

study, then you must submit a copy of your approval letter to the Graduate School. Send 
it attached to an email addressed to johnprussell@siu.edu.  

• It is recommended that you make a statement within your methods section that the study 
methods have been approved by the SIUC Human Subjects Committee or SIUC 
Institutional Animal Care and Use Committee. You are not required to include the 
approval letter in your paper. If you do include it in your appendix, be sure to white out 
any hand signatures.  

 
GRADUATION 

• Make sure you don’t have any INC or DEF grades on your transcript (other than EAHE 
600B Capstone). You must complete all incomplete courses before graduation. 

• Ed.D. diplomas are released to graduates on the day of commencement for May and 
December. For August graduates and those who don’t attend commencement, please 
allow up to 8 weeks after graduation to receive your diploma. You can arrange to pick up 
your diploma at the Graduate School if you prefer by sending an email to 
grad.graduation@siu.edu.  

• If you have questions about graduation applications or procedures, contact 
grad.graduation@siu.edu. 

• If you have questions about the commencement ceremony, visit 
https://commencement.siu.edu/ 

 
 

Questions about formatting a Capstone Report should be directed to Mr. John Russell at 
johnprussell@siu.edu.  

 
Questions or feedback regarding this Guidelines document should be directed to Dr. Rose 
Moroz, Assistant Dean of the Graduate School, rmtmoroz@siu.edu.  
 

Revised December 20, 2024 
 

 

mailto:johnprussell@siu.edu
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